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Intermediate HTML 
November 5, 2001 

 
 

LAB EXERCISE: 
designing your portfolio with a table 

 
 
A. Establishing a Path 
 
A simple way to organize a lot of content like this is to establish a path of folders in your Public HTML, 
and to do that we're going to have to open FTP to Dante.  When in the computer labs the direction is: 
 
 Start > Programs > FTP Clients > SSH Secure FTP > Secure FTP Dante  

Enter your "public_html" or "students_html"folder by double clicking on it. 
When you are inside your public_html folder Right Click and select New Folder 
Name this folder folio 

 
You have now established a path in your student page.  The URL will read: 
 http://students.washington.edu/UWNetID/folio/ 
 
Now that we have our space established we’re going to disconnect from Dante  and begin writing our 
HTML file. 
 
B. Setting up an HTML File 
 
For this workshop, to effectively introduce the concept of HTML code, you are going to be building a 
Web page from scratch.  We will be constructing the text using the Notepad program and will periodically 
view the presentation in Explorer as we proceed.   
 
1. To open Notepad from the desktop, select: 
 Start > Programs > Accessories > Notepad   
 
2. Prior to typing anything in the blank document, begin first by saving the file: 

• Select: File > Save As 
• Save in: A Drive (if you’ve brought a disk) or C Drive and create a personal folder  
 with your name 
• File name: index.html 

 • Save as type: all files 
This will not replace your Basic HTML file.  This file will be the index for your folio folder that we 
established at the beginning. 
 
C. Starting to Code 
 
Once a file has been saved, it is now possible to begin writing the document.  Previously, we built a 
webpage from scratch and this exercise will build from that session.  If you currently don’t have the 
information from the basic session you can download the PDF copy from the iSchool homepage at: 
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> http://www.ischool.washington.edu/technology/bootcamp/default.htm 
 
1. Defining HTML 
The first action needed is to convey to the computer that the document being created is to be in HTML.  
To do that, the following tags should be inserted:   

<html> 
</html> 

 
These tags will go at the top and bottom of the HTML document.  All of the content will fall in between 
these tags. 
 
2. Adding a Title  
The next step required is to supply the page with a title to identify whose page it is: 

<title>Your Name’s Portfolio</title> 
 
This command will tell the browser to write this statement in the title bar. 
 
3. Formatting the Head and Body of the Document 
The body tag is rather complex so, for our purposes, we will approach it in stages.   
 

a. What you have written so far should look like this: 
<html> 
<title>Your Name’s iSchool Portfolio</title> 
</html> 
 

 b. The pair of tags defining the head of the document can be wrapped around the title tag: 
  <html> 
  <head><title>Your Name’s iSchool Portfolio</title></head>  
  </html>  
 

Note: If we were to add metadata to this page it would be in a <meta> tag in the documents head. 
 

c. The pair of tags defining the body will be added under the title line: 
<html> 
<head><title>Your Name’s iSchool Portfolio</title></head>  
<body> 
</body> 
</html> 

 
d. Next, we will add color instructions, using hexadecimal codes, for the browser, which are part 
of the body start tag.  For this exercise, we are only going to use the same color scheme as the 
sample web page used in the demonstration; they may easily be changed later.  Remember, the 
commands for color changes need to be made in the body tag to show up properly. 

 
• Background color 

   <body bgcolor="0084A5"> 
This will turn our background color blue.  Notice straight quotation marks have 
been used.  Part of the reason why we work in Notepad is that smart quotes [“ ”] 
confuse the browser.  Always make sure that you close your quotation marks and 
that there is no space between the command, the equal sign, and the value. 
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• Text Color 
<body bgcolor="0084A5" text="FFFFFF"> 
This will turn the text white 

 
• Link Color 

<body bgcolor="0084A5" text="FFFFFF" link="FFFF10"> 
This will make links that the user hasn’t yet followed appear yellow. 

 
• Viewed Link Color 
<body bgcolor="0084A5" text="FFFFFF" link="FFFF10" vlink="E0E0E0"> 
This will make viewed links appear grey. 

 
 When you close a body tag it is unnecessary to repeat all the color information.  The 
 </body> tag is sufficient. 

 
e. Save your work. 
 

D. Viewing our Work 
 
We’ve now reached a point where we can actually watch what’s going on as we’re working.  After 
opening up Internet Explorer type in the URL of your file into the address bar.  It should look like this: 

C:\yourfile \mypage.html 
 
E. Defining a Table for Page Layout 
 
1. The Table Tag 
The table tag tells the browser that the content between these tags is going to be formatted into columns 
and rows.  

<table> 
</table> 

 
2. Table Attributes 
 

a. Similar to the <body> tag, tables must be formatted color data simply copy (ctrl + C) and paste 
(ctrl + V) the same information from the body tag into our table opener: 
 
<table bgcolor="0084A5" text="FFFFFF" link="FFFF10" vlink="E0E0E0">  
 
This will make the table blend into the background instead of being blank white space with black 
text. 
 
b. Next we will add a tag to define our cell borders.  This is only to illustrate the properties of the 
table in this exercise and it will be removed at the end. 
 
<table border="1" bgcolor="0084A5" text="FFFFFF" link="FFFF10" vlink="E0E0E0"> 
 
c. Finally we will add cell padding to give the text to follow some room.  This is simply for visual 
effect. 
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<table border="1" cellpadding="10"  bgcolor="0084A5" text="FFFFFF" link="FFFF10" 
vlink="E0E0E0"> 
 

 d. Save your work. 
 
F. Constructing Your Table 
 
1. Columns  

 
a. First we need to define our columns, the vertical arrangement of our page.  To do that we must 
establish a group of columns and assign attributes to them. 
<table……> 
<colgroup> 
</colgroup> 
</table> 
 
 
 
b. Next we have to tell the browser how many columns we are establishing.  This is going to be a 
simple four cell table so we need 2 columns. 
<colgroup span="2"> 
 
c. Now we have to insert our two column tags 
<table……> 
<colgroup span="2"> 
<col> 
<col> 
</colgroup> 
</table> 
 
e. Written this way the cells in each of these two columns will expand to fit the content put in 
them.  However, we want the second column to have a defined width so that our text remains in 
an easy to read format.   
<table……> 
<colgroup span="2"> 
<col> 
<col width="650"> 
</colgroup> 
</table> 
 
The “650” in the width indicator is the exact number of pixels that the browser will allow within 
this column.  Any text that exceeds the allotted 650 will be pushed down to the next line. 
 
f. Save your work  

 
 
2. Rows  
Now that we have established our two columns we need to establish how many rows we will have.  We 
only want to have two rows so that we can establish our four celled table. 

</colgroup> 
<tr> 
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</tr> 
<tr> 
</tr> 
</table> 

 
3. Establishing a Data Set 
In order for the information to be placed in the proper cell we need to define each cell in the row.  Our 
content will go in these cells. 

</colgroup> 
<tr> 
<td></td> 
<td></td> 
</tr> 
<tr> 
<td></td> 
<td></td> 
</tr> 
</table> 

 
Save and Refresh your work. 

 
G. Entering Content into a Table 
 
The content that you enter into a table has to be constructed cell by cell.  This can be fairly tedious, but 
don’t panic; we’ll just take it one cell at a time. 
  
1. Row 1, Column 1: Image Link 

a. In the basic lab you uploaded an image of a book for your homepage.  We are going to use that 
same image here, only we are going to make it much more useful.  In your first table data set 
enter: 

 <td><img src="/UWNetID/book.gif"></td> 
 

This will pull the image book.gif from your file.  The browser will know to construct the rest of 
the “students.washington.edu” URL based on where we will place this file.   
 
b. Because we are not working in that folder you will get a broken image link.  Let’s put in an 
alternative identifier saying this image is a book. 

 <img src="/UWNetID/book.gif" alt="Book">  
 
 c. Let’s align our image so that it sits exactly in the center of the box 
 <img src="/UWNetID/book.gif" align="center" alt="Book"> 
 

d. Now, let’s make this image a hyperlink to our portfolio folder 
<td><a href="/UWNetID/folio/"><img src="/UWNetID/book.gif" align="center" 
alt="Book"></a> 
</td> 
 
e. Save and refresh.  Notice that there is a bright yellow link box surrounding our image.  Let’s 
remove that line to give our webpage a more professional look. 
<td><a href="/UWNetID/folio/"><img src="/UWNetID/book.gif" border="0" 
align="center" alt="Book"></a>  
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</td> 
 
f. Save and refresh. 

 
2. Row 1, Column 2: Main Heading 

a. In this cell we’re going to enter our main page heading just the same way we did in the basic 
class. 
<td><center><h1>Your Name’s Portfolio</h1></center> 
</td> 
 
b. Save and refresh. 
 
c. Now we’re done with row 1. 
 

3. Row 2, Column 1: Menu Bar 
a. We’re going to make a left side menu bar that will link this portfolio index page to the five 
pages that illustrate our five different portfolio credentials: Teaching, Leadership, Service, 
Scholarship, and Technology. 

 <td> 
 <h2> 

Teaching<br> 
Leadership<br> 
Service<br> 
Scholarship<br> 
Technology<br> 
</h2> 
</td> 
 
b. Now we are going to create hyperlinks to each of these five pages.   
<td> 

 <h2> 
<a href="teaching.html">Teaching</a><br> 
<a href="leadership.html">Leadership</a><br> 
<a href="service.html">Service</a><br> 
<a href="scholarship.html">Scholarship</a><br> 
<a href="technology.html">Technology</a><br> 
</h2> 
</td> 
 
c. Now lets remove the underline from our links by adding a style note. 
<td> 

 <h2> 
<a href="teaching.html" style="text-decoration:none">Teaching</a><br> 
<a href="leadership.html" style="text-decoration:none">Leadership</a><br> 
<a href="service.html" style="text-decoration:none">Service</a><br> 
<a href="scholarship.html" style="text-decoration:none">Scholarship</a><br> 
<a href="technology.html" style="text-decoration:none">Technology</a><br> 
</h2> 
</td> 
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d. To ensure that our menu bar is always at the top of this cell, regardless of how much text goes 
into column 2 we have to vertically align this data set. 
<td valign="top"> 
 
e. Save and Refresh your work. 

 
4. Row 2, Column 2: Text Area 

a. Because we’re going to input a lot of text into this area save yourself the trouble of typing and 
open up my folio page at: 

 http://students.washington.edu/eriley/folio/ 
 

b. Go to the area of text that says “Introduction” and copy from “Introduction” to “index page” 
and paste all this text directly into your notepad file in the fourth table data set. 

 
H. Formatting Refresher 
 
Inside the text area above we’re going to use a few of our little formatting tags from the basic lecture as 
well as learn a few new ones. 
 
1. Embedded Notes 
To make a reference for yourself or others who are viewing your source code you can embed a note 
anywhere in the text using the tag: 
 <!--……--> 
Let's insert a note before our fourth data set for future reference. 
 <td><!--This cell is where you will put your portfolio writing--> 
 
2. Centering  
Although this tag is being phased out in place of style sheets it still works, and probably will work for a 
good long while.  Let's center our second heading "Introduction." 
 <center>Introduction</center> 
 
3. Heading Size  
As we did in row 1, cell 2, we're going to adjust our header size for both the introduction heading and our 
text. 
 <center><h2>Introduction</h2></center>  
 <h3> 
 blah blah blah 
 </h3> 
 
4. Horizontal Rule  
Insert a line between the second heading and the text that follows. 
 <center><h2>Introduction</h2></center>  
 <hr> 

<h3> 
 blah blah blah 
 </h3> 
 
Note: The dotted line that transfers to your notepad window is not sufficient as a line, because the 
browser will simply read each individual dash as a character and display it.  You should always use 
Horizontal Rule instead for a clean line. 
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5. The Paragraph Tag 
This tag denotes the beginning and end of individual paragraphs.  It does NOT indent the paragraphs; it 
only places an empty line between each paragraph.  Insert paragraph tags around each paragraph in cell 
four. 
 <p>blah blah blah</p> 
 
6. Italics  
We're going to make the bottom line an italicized note telling people that the book icon is a hyperlink. 

<p><i>Note: the book icon in the top left corner will always return you to this index 
page.</i></p> 

 
 
 
 
7. Copy and Paste  
We have been doing this all along, but as an exercise in how to use Ctrl + C and Ctrl + V each paragraph 
in cell four has a word that corresponds to one of our menu items.  Highlight the code from the menu text, 
copy it, and paste it over the text in cell four to have links inside the text area.  An example would be: 
 <p>My <a href="teaching.html" style="text-decoration:none">Teaching</a> section will  
illustrate my philosophy as well as my ability to teach basic and advanced material in Library and 
Information Resources to a diverse population.</p>  
 
I. Character Entities 
 
Some HTML tags don't use angle brackets,<>, but instead use ampersand semicolon,&;.  Two of the most 
important character entities are the non breaking space, &nbsp; , and the copyright symbol, &copy; .  
We're going to put a copyright symbol on our individual pages (don't worry, I won't sue for infringement). 
  

After we've closed our table, insert the following text. 
 </table> 
 <br> 
 <center>&copy; Your Name, 2001 <br> 
 This work may be used for educational purposes. 
 </center>  
 </body> 
 </html> 
 
Save and refresh your work. 
 
J. Finishing Up 
 
At this point you should have the following text in your notepad. 
 
<html> 
<head><title>Your Name's Portfolio</title></head> 
<body bgcolor="0084A5" text="FFFFFF" link="FFFF10" vlink="E0E0E0"> 
<table border="1" cellpadding="10" bgcolor="0084A5" text="FFFFFF" link="FFFF10" 
vlink="E0E0E0"> 
<colgroup span="2"> 
<col> 
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<col width="650"> 
</colgroup> 
<tr> 
<td><a href="/UWNetID/folio/"><img src="/UWNetID/book.gif" border="0" align="center" 
alt="Book"></a></td> 
<td><center><h1>Your Name’s Portfolio</h1></center></td>  
</tr> 
<tr> 
<td valign="top"> 
<h2> 
<a href="teaching.html" style="text-decoration:none">Teaching</a><br> 
<a href="leadership.html" style="text-decoration:none">Leadership</a><br> 
<a href="service.html" style="text-decoration:none">Service</a><br> 
<a href="scholarship.html" style="text-decoration:none">Scholarship</a><br> 
<a href="technology.html" style="text-decoration:none">Technology</a><br> 
</h2> 
</td> 
<td><!--This is the cell where you will put your portfolio writing--> 
<center><h2>Introduction</h2></center>  
<hr> 
<h3> 
<p>Hello there! This is my preliminary design for my graduation portfolio. The Information School 
at the University of Washington requires all graduates from the MLIS program to demonstrate 
their mastery of each of the five categories to your left.</p> 
 
<p>My <a href="teaching.html" style="text-decoration:none">Teaching</a> section will illustrate 
my philosophy as well as my ability to teach basic and advanced material in Library and 
Information Resources to a diverse population.</p>  
 
<p>The <a href="leadership.html" style="text-decoration:none">Leadership</a> page will 
demonstrate my skill and work as a leader both inside the Information School and out.</p> 
 
<p>Inside the <a href="service.html" style="text-decoration:none">Service</a> section you can 
find both an online and PDF copy of my resume for easy download, and a description of my work 
in the field of Library and Information Science.</p> 
 
<p><a href="scholarship.html" style="text-decoration:none">Scholarship</a> contains the text of 
an research paper or professional document that I have produced during my time here in the 
Information School.</p> 
 
<p>The <a href="technology.html" style="text-decoration:none">Technology</a> section 
illustrates my understanding and mastery of technological innovation in its many forms.</p> 
 
<p><i>Note: the book icon in the top left corner will always return you to this index page.</i></p>  
</h3> 
</td> 
</tr> 
</table> 
<br> 
<center>&copy; Your Name, 2001 <br> 
This work may be used for educational purposes. 
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</center>  
</body> 
</html> 
 
 
Return to the top of your notepad and go to the open table tag. 

<table border="1" cellpadding="10" bgcolor="0084A5" text="FFFFFF" link="FFFF10" 
vlink="E0E0E0"> 

 
Remove the border attribute from your table and your lines will disappear. 

<table cellpadding="10" bgcolor="0084A5" text="FFFFFF" link="FFFF10" 
vlink="E0E0E0"> 

 
Save and refresh your work. 
 
K. Example 
 
Your final result should look like this: 
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L. Establishing Multiple Pages 
One of the easiest ways to have all your pages look the same is to use File > Save As like a form of copy 
and paste.  We know that we will want all of our pages to look exactly like this, that's why we took all the 
trouble to design this page this way. 
  

Go to File > Save As 
 Change the File Name in the “File Name:” box to teaching.html 
 
Now you’ve got your teaching page.  Now all you’d have to do is enter the content for your teaching 
section, and you’ll have a real page attached to your link.  
 

Repeat for all five files named in this document 
 
M. Uploading Files 
 
Now we have to import our files that we’ve created into our new folio space. 
 
Open Dante 

Start > Programs > FTP Clients > SSH Secure FTP > Secure FTP Dante  
Enter your "public_html" or "students_html"folder by double clicking on it. 
Now Open your "folio" folder 

 
WARNING: Always verify you are in the correct folder before uploading; otherwise you may erase 
other material in your HTML account.  This is especially hazardous for files named "index.html."  Dante 
provides you with a visual display on the left hand side of the screen showing where you are in the folder 
structure.  Make sure your folio folder is open. 
 
Now we have to upload all of the files we created today into the folder labeled "folio." 
 
 Click the UP arrow to begin uploading 
 Locate the files that we created today 
 Highlight every item in the list 
 Now push the upload button at the bottom of the window 
 
All your files should be in the proper place now. 
 
Check the properties associated with each and verify that they are at permission mask 644 
 
 To check the properties: 
 Highlight an individual file (for example your new index.html) 
 Right Click on the item to get the pop up window 
 Select Properties 
 Make sure that there is Read Access for all three groups and Write Access for you. 
 
Once all your properties have been adjusted for every file your documents are now officially published. 
 
N. Linking from your Main Page 
 
It does no good to establish a path if no one knows it exists.  So, you have to establish a reference to it 
from your top level homepage.   
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Now that we’ve uploaded all of our pages we’re going to erase the copies from the local drive. 
 
1. Cleaning up our C Drive  
Here we’re going to erase the files that we created today to avoid confusing our file names. 

 
Reduce your Dante window 
 (make sure that you perform this step otherwise you may get confused) 
 
Open your Windows Explorer 
Open the folder that we created on the C Drive  
Highlight all the files that we created in class 
Right Click to open the pop up menu 
And select Delete 

 
2. Downloading Your Homepage  
This step will pull a copy of your homepage code from Dante and place it on your local drive. 
 

Reduce your C Drive window 
  (make sure that you perform this step otherwise you may get confused) 

 
Increase your Dante window 
Go to the top level in your folder structure  
Open your public_html folder 

 Download to your hard drive folder a copy of the file marked as index.html 
  
3. Updating Old Source Code  
Now we’re going to edit the file  
 

Reduce your Dante window 
(make sure that you perform this step otherwise you may get confused) 
 

Increase your C Drive window  
Select the index.html page that we just loaded 
 Notice that the index page looks like an Internet Explorer page 

 Opening this document will launch a browser window 
In order to edit the code you have to View > Source   
 This will open a notepad file for you to change the source code. 
 

 
Anywhere within your code that you think it would be appropriate add the following line: 
 
 Here’s a link to my <a href="/UWNetID/folio/">Portfolio</a><br> 
 
This establishes a link from your main page to your portfolio path. 
 

Save  your work and  Refresh your browser 
 
You should notice that your page now has a link to your new folio space.  This link won’t work properly 
until it’s loaded back into Dante  
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4. Uploading Your New Homepage 
 
Now we have to import our updated homepage created into our new public html. 
 
Open Dante  

Start > Programs > FTP Clients > SSH Secure FTP > Secure FTP Dante  
Enter your "public_html" or "students_html"folder by double clicking on it. 

 
WARNING: Always verify you are in the correct folder before uploading; otherwise you may erase 
other material in your HTML account.  This is especially hazardous for files named "index.html."  Dante 
provides you with a visual display on the left hand side of the screen showing where you are in the folder 
structure.  Make sure your public_html folder is open. 
 
Now we have to upload our revised page. 
 
 Click the UP arrow to begin uploading 
 Highlight the index.html  
 Now push the upload button at the bottom of the window 
 
Your file should be in the proper place now. 
 
Check the properties associated with this item and verify that it’s at permission mask 644 
 
 To check the properties: 
 Highlight an individual file (for example your new index.html) 
 Right Click on the item to get the pop up window 
 Select Properties 
 Make sure that there is Read Access for all three groups and Write Access for you. 
 
 
 
 
 

Congratulations! 
 

You've made it through the intermediate HTML workshop. 
 


